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Learn to: 

• Become familiar with E.WIN features 

• Troubleshoot with ease 

• Develop techniques to deal with difficult site 

situations 

• Use tools to fix all sorts of problems 
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CHAPTER 1 

1.0 INSTALLATION 

Before you can start operate the E.WIN software, you have to make sure the software has been 

properly installed at your PC and the hardware has also connected properly. This section will guide 

you through whole installation of both software and hardware. 

1.1 Hardware Configuration 

There are few main components: 

Controllers 

E.WIN can support up to eight buses. One PC serial port can support up to 16 controllers 

which is consider as one bus. Thus, E.WIN software can support at total 128 controllers. 

The unit number of each controller at each bus can be configured from 1 to 16; the controller 

won’t accept the unit number value bigger than 16. 

In E.WIN software, the physical number of each controller will be assigned as follow: 

Bus Number 
Unit Number in 

hardware 

Physical number in 

software 

1 1 Bus 1 

16 16 

1 17 Bus 2 

16 32 

1 33 Bus 3 

16 48 

1 113 Bus 8 

16 128 

 

Communicators 

Communicator is the device to allow PC and controller communicates to each other. There are 

3 types of communication method. 

� Multidrop 

It is serial communication which using 4 wires (TX+, TX-, RX+, RX-). Due to multidrop is 

run in 12V, so an external power must be provided to the communicator. The 

communicators that having multidrop communication is as follow: 

1. EL70Y which support softkey2. The communicator baud rate is adjustable from 

2400 and 9600. 
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2. EL70B which only support old softkey. Thus, EL70B is not suitable for bus1 when 

E.Key is needed. EL70B can be used under E.WIN Limited Mode (4 door maximum, 

no EsofKey2 is required) and as supplement communicators for bus 2, 3 onwards. 

The communicator baud rate has fixed at 2400. 

3. EL70T which does not support software key. The communicator baud rate has fixed 

at 2400. 

� RS485 

It is serial communication which using 3 wires (D+, D-, GND). RS485 is run at 5V, so no 

external power supply is needed. It can direct take the power from PC serial port or USB 

port. The communicators that having RS485 communication is as follow: 

1. EL70Y which support software key. Please note that EL70Y can also support 

multidrop communication. But, both type of communication cannot run in the same 

time. 

2. CV4823 which does not support software key. 

� TCP/IP 

By adding LAN module or terminal server, the controller allows to run in LAN 

environment. There are 2 type of terminal server, EL78A which using Chiyu LAN module 

and EL70L which using Znet LAN module. The IP configuration of both terminal servers 

is different. Please refer to their individual manual for the detail of setting up of IP 

properties. 

 

After get ready all devices, please setup the system as below: 

 

 

 

 

 

 

 

Before start to run the system, please ensure that: 

1. The wiring for communication part between controller and communicator is connected 

properly. You may refer to the individual controller’s or communicator’s wiring diagram 

for the correct connection. 

2. Each of the controllers has been cold start and assigned with an identical unit number. 

The unit number of the controller cannot be repeated in the same bus. 

3. If you are using multidrop communication, please make sure the power of communicator 

has been turned on. 

4. The baud rate of controller must be same as baud rate in communicator. 

5. If you are using EL70Y or EL70W, please make sure the USB driver has been installed 

properly. 

PC 

Communicator 

Software Key 

Door1 Door2 Door3 Door4 

Multidrop / RS485 
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1.2 Software Installation 

Insert E.WIN CD into the CD-ROM, the CD will automatically run the setup launcher if your OS 

support Auto play feature. To run the setup manually, browse the CD using Windows Explorer, 

run E.Win.exe. It is advisable to install the software under PC administrator account, 

especially in Window Vista or Window 7 operating system. 

The installation will be started from a welcome screen; it will show the software version, click 

“Next” button to proceed. 

 

Select destination location for E.WIN folder. The default is at C:\Program Files\EdotWin, you 

may change the destination from the “Browse” button. 
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This screen will prompt you whether to install a backup copy which allow you to roll the system 

back to a previous state after uninstall of E.WIN. If “Yes” is selected, then you need to select 

the destination location for backup file. 

 

Enter name of Program Manager Group you want to add E.WIN. 
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Click “Next” to start installation. 
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After installation complete. Click at “Finish” button to exit installation setup. 

 

If you are installing E.WIN in Vista or Window 7, there are few settings to do after installation 

due to User Access Control in Vista. 

You have to set the shortcuts to have the property of “Run As Administrator” for the program 

run properly under vista. 

1. Right click the software shortcut at desktop and point to ‘Properties’ 

2. On the ‘Compatibility’ tab, under ‘privilege level’ option, select the checkbox ‘Run this 

program as an administrator’. 

3. Click “OK” to exit 

 

Troubleshooting 

If you fail to run the software due to the BDE is not created during installation. 

1. Go to the Control Panel and run the BDE Administrator. 

2. On the ‘Database’ tab, point the ‘Databases’ and right click to select ‘New’ 

3. Under ‘Database Driver Name’, select ‘STANDARD’ 

  

4. Click at ‘path’ to select the software path. 

5. Select the EdotWin folder as shown below and click ok. 
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If you want to edit the .ini file of the software but fail to save the file after editing in Window 

Vista. 

1. Right click the notepad at All programs > Accessories. 

2. Point to ‘Properties’ 

3. On the ‘Compatibility’ tab, under ‘privilege level’ option, select the check box ‘Run the 

program as an administrator’. 

4. From notepad, open the .ini file for editing. 

OR you can open the .ini file from command prompt (DOS) for editing. 

1.3 E.WIN License Activation 

Elid supply different package of E.WIN. E.WIN/0 (limited edition) does not require license key 

(please refer to section 13.3 on how to activate the E.WIN limited edition). E.WIN limited 

edition can only control at maximum 4 doors. For the system that more than 4 doors, you may 

need to purchase license key. 

EL70Y is a communicator and also a device for license key detection. E.Key has to be 

inserted to EL70Y CN3. 
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Once you run E.WIN Designer or E.WIN Manager, the software will start to detect key. 

 

If software fails to detect key, a message ‘No Softkey 

Detected’ will be prompted, and you can only enter into 

demo mode. 

If the softkey detected, you may need to enter the User ID 

and password to access the software.  

The default user ID and Password is as follow: 

User ID    : ELID 

Password  : elid 

 

 

Each license key comes with a piece of paper printed with ‘Activation Code’. You can activate 

the license at E.WIN Manager > Help > License Information. 

 

The E.Key information and serial number will be read and display at the screen. Key in the 

activation code and click upgrade button to activate it. 

Troubleshooting Tips: 

1. Please make sure the key is inserted properly. 

2. Check whether the key is for E.WIN software, it might be wrong key inserted. 

 

 

 



 

 
 
 

14 

1.4 Installed E.WIN by Administrator Account and operate using User Account 

If you install the E.WIN software by administrator account and you would like to allow other 

user account from the same PC to operate the software, you have to do the following step: 

1. Turn off the ‘Simple File Sharing from ‘Folder Option’ before you can access the security 

of the folder 

At My Computer Tools menu, click ‘Folder Options’. 

Select the View tab. 

In the Advanced Settings section, clear the ‘Use Simple File Sharing (Recommended)’ 

check box. 

 

2. Right mouse click at C:\Program Files\EdotWin folder and select ‘Properties’ 

3. Click at Security tab, then set Read / Write rights for that user. 
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CHAPTER 2 

2.0 SETTING UP TO LINK TO A CONTROLLER 
 

2.1 Create a Controller in E.WIN Designer 

Before you can start to operate the system, you should create the system controller first. 

Click on the Designer shortcut on the desktop to launch E.WIN Designer. 

 

1. Right mouse click at E.WIN Designer screen, and select ‘New Controller’, or go to Setup 

> New Controller 

2. Enter the Tag Name and Description of the controller. 

3. Enter the physical point of the controller, such as 1, 2, 3 and etc. 

Bus 1 (1 – 16), Bus 2 (17 – 32), Bus 3 (33 – 48), Bus 4 (49 – 64) 

For example, the logical point of the controller unit number 3 of Bus 2 should be ‘19’. 

4. Select the controller type. For 2-door controller, xxxxA represent first door and xxxxB 

represent second door. 

5. If you are using LAN communication, you may enter the IP address to define the 

controller. 

6. Once you click ‘OK’, a controller icon will appear on the floor plan, you can drag the icon 

to the desired position. 
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2.2 Connection Test between E.WIN and Controller 

Once you have successfully setup the system, you can now test the connection of each 

controller to the software by using <Detect Controller> feature at E.WIN Designer. 

 

Click the ‘Detect’ button at the top panel of E.WIN Designer, screen below will be shown: 

 

Serial Communication 

1. Enter the COM port number for each bus. 

2. Select which bus to detect. 

3. Click scan button, all the detected controllers will be listed down on the scanning result 

screen. The controller will reply with the controller model and also firmware version, 

otherwise it will show no reply. 

LAN Communication 

1. Select the controller to be detected from the drop down list. 

2. The IP address and the logical point number of the relevant controller will be displayed. 

3. Click ‘Test’ button to check its connection, the status of the controller will be shown on 

the scanning result screen. 
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2.3 Send Date / Time in E.WIN 

Exit E.WIN Designer, then click E.WIN Manager icon on the desktop to launch E.WIN 

Manager. Your first task is to setup all the controllers to have same date/time with the PC. 

This function is for you to synchronize all controllers’ date / time to system date / time. 

1. Click ‘Control’ button, then select ‘Send Parameter’. 

 

 

 

 

 

 

 

 

2. Select which controller to send, you can send to only one controller, all controllers or 

selective controllers. 

3. Tick at ‘Date/Time’ checkbox. 

4. Click ‘Send’, a message ‘Successful’ shall be appeared if it is successfully sent. 

2.4 Pulse Door Open in E.WIN Manager 

1. Right mouse click at the controller icon, then select ‘Pulse Door Open’. Alternatively, you 

can also double click at the controller icon and select ‘Pulse Door Open’ 
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2. The particular door will be unlocked for few second. Please observe the change of 

controller icon to indicate the door status. 

 

Troubleshooting: 

What to do if the door unable to unlock after ‘Pulse Door Open’ signal send successfully. 

1.   Check whether the door sensor is connected properly. If the door sensor is in open 

status, door lock won’t release.  

2.   To confirm whether the door sensor is in good condition, try to bypass the door 

sensor by short the +12V and DS point on the controller’s door connector by using a short 

wire, then send ‘Pulse Door Open’ Signal again. 

2.5 Add a Card with Full Access in E.WIN Manager 

1. Click ‘Cards’ button.  

 

2. Click ‘Add’ button for new entry. 

3. Enter ‘Staff No’, ‘Card No.’, ‘Staff Name’ and ‘Card’s start and expiry date’. 

4. Select the ‘Door Accessibility’ as ‘Acc All’, ‘Department’ and ‘Position’. The ‘Floor 

Accessibility’ is only valid for lift controller. 

5. Click ‘Update’ button to send card to controller. 
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2.6 Change Timer / Time Zone / Access Level of Card Holder 

You can control door accessibility of a card holder by using timer, time zone and access level. 

The example below will interpret the relation between timer, time zone and also access level. 

Please refer to section 3.2 for the detailed explanation. 

 

Example 

Consider a small factory with 2 doors to be protected by card access, main door and store 

room. 

� Factory Manger can access main door at anytime and store at office hour. 

� Store keeper can access main door and store at office hour. 

� Factory operator can only access main door at office hour 

Office hour: Monday to Friday (8:00 to 18:00) 

           Saturday (8:00 to 12:00) 

1. Define a new timer for normal day office hour (TMR3) 

2. Define a new timer for half day office hour (TMR4) 

 

3. Define new time zone for office hour (TZ3) 
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4. Define access level for Factory Manger, Store Keeper and also Factory operator. 

 

 

 

 

5. Change the ‘Door Accessibility’ of the particular card holder. 
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2.7 Disable a Card from Accessing Any Door 

You can disable a card from accessing any door by edit the ‘door accessibility’ of the particular 

card to ‘No Acc’ (No Access). 

1. Select the card to be disabled from the card database. 

2. Edit the ‘Door Accessibility’ to ‘No Acc’. 

3. Click ‘update’ to save the change to the E.WIN database and send the latest door 

accessibility to all controllers. 

2.8 Remove a Card from The System 

1. Select the card to be removed from the card database. 

2. Click delete button to remove the particular card from the E.WIN card database and also 

remove from the controller’s card database. 

Troubleshooting: 

What to do if you have disable a card from accessing a particular door or removed the 

card from the card database, but the card still able to gain access? 

You can use ‘Verify & Rectify’ function to check the differences between card holder 

stored in the controller and E.WIN database. 

1. Click at ‘Control’ button and select ‘Card DB Control’ 

2. Select ‘Verify and Rectify’ tab 

 

Choose the reader to be compared and click ‘Start’ button. 
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CHAPTER 3 

3.0 TERMS AND EXPLAINATION 
 

3.1 Controller / Sensor / Output 

Controller 

Controller is the main device to control the door activity. ELID provide various range of 

controller which is supported by E.WIN. 

� EL3xx Series (such as EL360 and EL370) 

� EL13xx Series (such as EL1300, EL1310 and EL1330) 

� EL22xx Series (such as EL2200, EL2205, EL2205L and FC1205) 

� EL23xx Series (Such as EL2308 two doors controller) 

� EL2800 four doors controller 

� EL3000 Series (Biometrics, fingerprint controller) 

Sensor 

Most of the ELID Controllers provide Input Points which used to record that something is 

present or that there are changes in something. Please refer to the User Manual of the 

Controllers you are using to make sure the number of provided Input Points.  

Sensor points can be configured as either “Status” or “Alarm”.  

A Status Point is one that merely monitors the state of input, usually a contact of open or 

close.  

An Alarm Point is one whose activation must raise alert to the system operator, for instance, a 

door being ‘forced open’. For such kind of points, E.WIN provides arming and disarming 

commands. When a point is disarmed, it means that it is not in use, and should not be 

expected to raise any alarm. 
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How to operate a sensor at E.WIN 

1. Define a sensor point from E.WIN Designer. Please select the operation mode of the 

sensor, either status or alarm and to which controller the sensor attach to. 

2. You can arm or disarm an Alarm Sensor manually by pointing the cursor to the sensor 

icon and double click. You can also include or exclude a Status Sensor. 

 

3. Alternatively, sensor arming can be control by time zone. Select sensor from database 

menu and choose an appropriate ‘Arming Time Zone’ from the drop down list. 

 

Output 

Most of ELID Controllers provide Output Points. Please refer to the User Manual of the 

Controllers for the number of outputs provided.  

These points may be set at the Controller (not at E.WIN) to function in the following manner.  

I. To be switched ON/OFF manually from a PC or locally from a Special Card or 

Master Card.      

II. To be switched ON/OFF automatically by a timer.  

III. To be switched ON/OFF automatically by certain input conditions (EL2xxx only).  

For EL2xxx, it is possible to activate the output with a pulse of defined on period. 

However, all these settings are done at individual readers and not at E.WIN. 
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How to operate an output at E.WIN 

1. Define an output point from E.WIN Designer. 

2. You can on and off the output manually by double clicking at the output icon. 

 

3. Alternatively, the output can be controlled automatically by using time zone. Select 

Outputs from database menu then choose an appropriate time zone. 

 

 

3.2 Timer / Time Zone / Door Accessinility 

Door accessibility allows proper control of who, when and which doors are granted access. 

For example, you can set door accessibility Office_Hour such that the staff can enter Main 

Door and Back Door from 8am to 6pm, for Monday till Friday, while blocking them on Saturday, 

Sunday and Holiday. 

Timer is the time range that you can assign to the time zones, so that each particular day in 

the time zone can be assign with a set of a time range. Timer would be the time each particular 

card can be access a door in a day. Timer format defined is a 24 hour format. 

Door Accessibility holds particular controller and Time Zone that specific cardholders are 

allowed with access. This is useful in managing sites or areas (installed with individual 

controller) of restricted access. 
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How to add a new Timer 

Example: add one set of working period timer. 

IN: 08:30  LUNCH OUT: 12:30  LUNCH IN: 13: 30  OUT: 17:30 

1. To add a new timer, click at Add button 

2. Key in the name to represent the timer 

3. Key in Start Time #1 (08:30) 

4. Key in End Time #1 (12:30) 

5. Key in Start Time # 2 (13:30) 

6. Key in End Time #2 (17:30) 

7. Click update button to update the Timers database 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

    

How to add a new Time Zone 

1. Click Add button. 

2. Enter time zone name in the field labeled “Time Zone Name”. 

3. Move to the “Timer Tag” field for Sunday and enter the timer by selection from the 

drop-down list box. System automatically updates the rest of the days' Timers. 

(Re-select at one of day's Timer list box if the auto-change is not what you intended.) 

4. Click Update to save record. 

 

 

 

 

 

 

 

 

1. Click ‘Add’ 

button to add 

2. Key in Timer 

Tag name 

3 & 4. Key in Start time 

and End time #1  

5 & 6. Key in Start 

time and End time #2 

7. Click ‘Update’ 

button to update 

Click ‘Cancel’ 

button to abort 



 

 
 
 

27 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   How to add a new Door Accessibility 

1. Click ‘New’ button. 

2. Insert Accessibility Category Name under New Accessibility screen. 

3. Click Update button (New Accessibility Screen). 

4. Select reader name under Reader Name list. 

5. Select time zone under Time Zone list. 

6. Click Save button to save into database.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Click to add 

Time Zone 

2. Insert Time 

Zone name 

3. Click to browse 

Timer setting 

4. Click update 

to save record 

1. Click New 

2. Insert Access 

3. Click update  

4. Browse and select 

Click here to see detail 

5. Browse and 

Click here to see detail about 
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3.3 Floor Zone / Floor Accessibility 

Floor Zoning is applied only to lift access controllers, and that the traffic of access is low. It is 

used for restricting cardholders to accessing designated floors. System handles up to 64 

floors.  

Floor Accessibility determines which controller and Floor Zone, a cardholder is allowed 

accessing. So, the physical mounting of controllers are directly associated to the servicing of 

particular floors' accesses (or floor zone). This means that a controller (reader) mounted on 

the 2
nd

 floor of a building cannot possibly be assigned with floor zone(s) that covers floors 8 

and 10. If your building has multiple lifts (and each covers certain floors), you may then 

enforce this by limiting cardholders to gain access only to certain lift.  

How to add a new Floor Zone 

1. Click Add button (Floor Zone name automatically generate) 

2. Define floor that can be gained access into 

3. Click Update to store data 

 

 

 

 

 

 

 

 

 

 

 

 

How to add a new Floor Accessibility 

1. Click “New” button. 

2. Insert Accessibility Category Name under New Accessibility screen. 

3. Click “Update” button (New Accessibility Screen). 

4. Click “Add” button to add reader and floor zone 

5. Select reader name under Reader Name list. 

6. Select Floor Zone under Floor Zone list. 

7. Click “Close” to save the new floor accessibility and close the window. 

 

 

 

 

 

1. Click Add 

Change floor 

2. Define floor    

3. Click update 

Click to browse 
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3.4 Anti-passback 

Anti-passback command is to restrict a card holder from multiple entries without badge for exit 

or vice versa. It is commonly use at car park system. When anti-passback turns on, card 

holder must follow the sequence of IN…OUT…IN…OUT; otherwise, it will cause 

anti-passback alarm and the card holder will be blocked from accesing the door/gate. 

Careless user can be blocked outside should he followed someone else into the office, instead 

of badging his own card to get in.  

There are 4 selections for anti-passback: 

Off : Disable anti-passback. 

Reader : Makes use of the IN and OUT reader. A Card Holder who has come “in” is not 

allowed to come “in” again until he has gone “out”.  Similarly, a Card Holder 

that has gone “out” is not allowed to go “out” again unless he has come “in”. 

Timer : Anti-Passback is time controlled. A card can be badge in at second time only 

after a certain period of time has elapsed, unless you have badge out within the 

delay time. The delay time can be set at ‘Anti-passback Delay’ (The time delay 

is limited to 120 minutes) 

4-Reader : This command is only applicable to 2-door controller, such as EL2308. 

 

How to set Anti-passback 

1. At E.WIN manager, click ‘Control’ button. 

2. Select ‘Send Control Signal’ 

3. Select the ‘Reader Name’ to send and the type of anti-passback, then click ‘Send’ button. 

You can also reset the anti-passback by click the ‘Reset Anti-passback’ button. 

Note:  

Installing a card will reset the anti-passback status of the card. 

 

1. Click New 

Select door 

2. Click add 

3.  Select reader 

4.  Select Floor 

5.  Click to close 
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   How to set Anti-passback Delay 

1. At E.WIN Manager, go to Database > Controllers 

2. Choose the reader database to be edited and key in the desired ‘Anti-passback Delay’ 

value. 

 

3.5 Automatic Lock Release Time Zone 

This command allows the electric lock of a door to be automatically released for access 

without the need for a user to badge/swipe a card. The release is to be controlled by Time 

Zone. 

One scenario is during office hour, you may not want the staff to badge cards, especially when 

you have many staffs that are moving around frequently. 

 How to set Automatic Lock Release Time Zone 

1. Define the time period for automatic lock release. For example, every Monday to Friday 

from 9:00 to 17:00. 

2. Create a timer for 9:00 to 17:00. (e.g. TMR5) 

3. Create a Time Zone (e.g. TZ4) which using TMR5 (9:00 – 17:00) from Monday to Friday. 

4. At E.WIN Manager, go to Database > Controller, from ‘Auto Lock Release TZ’ drop-down 

list, selects ‘TZ4’. 
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3.6 Automatic PIN Disable Time Zone 

This command allows the reader (controller) access condition to be automatically switched 

from (Card and PIN) mode to (Card only) mode according to intended time zone. 

How to set Automatic PIN Disable Time Zone 

1. Define the time period for automatic PIN disable. For example, every Monday to Friday 

from 9:00 to 12:00 and 13:00 to 17:00. 

2. Create a timer for 9:00 to 12:00 and 13:00 to 17:00. (e.g. TMR6) 

 

3. Create a Time Zone (e.g. TZ5) which using TMR6 from Monday to Friday. 

4. At E.WIN Manager, go to Database > Controller, from ‘Auto Pin Disabled TZ’ drop-down 

list, selects ‘TZ5’. 

3.7 Transaction Code 

Transaction codes refer to one character code used to identify type of transactions occur at 

the controllers. For instance, ‘0’ for ‘Valid Entry’, ‘1’ for ‘Invalid Card’. Under normal 

circumstances, you can ignore the codes since in E.WIN screen, the codes are always 

displayed with descriptions.  
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Transaction 

Code 
Description 

Transaction 

Code 
Description 

0 Valid Entry F Output Off 

1 Invalid Entry G Exclude Sensor 

2 Duress Alarm H Include Sensor 

3 Wrong Pin I Status On 

4 Door Open Alarm J Status Off 

5 Pulse Door Open K Door Closed 

6 Wrong Customer Code L Keypad Locked 

7 Wrong Time Zone M Sensor Alarm #2 

8 Anti-Passback Alarm N Status On #2 

9 Valid Exit O Status Off #2 

A Sensor Alarm P Sensor Isolation #2 

B Sensor Isolation Q Sensor Arming #2 

C Sensor Arming Y Controller Up 

D Door Left Open Alarm X Controller Down 

E Output On   
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CHAPTER 4 

4.0 OPTIONAL FEATURES 
 

4.1 Tiny Web Server 

Tiny Web Server is an optional module of E.WIN. If you have purchase the license of tiny web 

server, you can view cardholder database, transaction, timers, time zones, online transactions 

and etc from a web browser such as Internet Explorer or FireFox. 

By default, the Tiny Web Server is off. You can enable Tiny Web Server from E.WIN Manager. 

Go to Setup > Preference, enable the Web Server by check the Web Server checkbox. 

How to access to E.WIN data by web browser 

1. Point your web browser from any PC to the PC which run E.WIN. For example, the PC 

running E.WIN holds IP address 128.100.30.15. So the URL should be 

http://128.100.30.15 

 

2. Enter the Login ID and Password of E.WIN. (By default is ‘ELID’ for both ID and 

password) 
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3. Choose the report type that you want to view from web browser. The report type for 

viewing is limited to  

� Card Holder 

� System Configuration (Controllers, Timers, Time Zone, Access Level) 

� Transaction 

� Attendance 

� Online Transaction 

Card Holder Report 

The card holder report can be viewed by following option: 

� Order by Name 

� Order by Staff Number 

� Order by Department 

� Display Photos 

This is an example of Card Holder report 

 

System Configuration Report 

System configuration consists of following report: 

� Controller List 
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� Door Accessibility 

 

� Time Zones 

 

� Timers 
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   Transaction Report 

   You can filter the transaction report with the following options: 

� Controller 

� Date 

� Transaction Type 

 

Attendance Report 

The Attendance Report can be filtered by 

� Department 

� Date 

� Name 
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Online Transaction 

You can click button to get online transaction 
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DATA COMMUNICATIONS 

 

 

 

 

 

 



 

 
 
 

39 

CHAPTER 5 

5.0 SERIAL COMMUNICATION PORT 
 

5.1 Check List of COM Ports Available 

You can check the available COM port from “Control Panel” 

1 At “Control Panel”, select “System”. 

2 From the system properties, click on ‘Hardware’ tab. 

3 Click on ‘Device Manager’ button and look for ‘Ports (COM & LPT)’ and click on the ‘+’ to 

expand and view the available port list 

 

E.WIN can also automatically detect the available com port from your PC, you can check the 

available com port list from E.WIN Designer detect function or E.WIN Manager, Setup -> 

Communication Setup. Here is the example on how to check the available port from E.WIN 

Designer. 

1. Log in to E.WIN Designer. 

2. Click at ‘Detect’ button. 

3. Click at the COM Ports drop-down list, all available com port will be shown as below. 
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5.2 How to Test COM Port 

1. Select Start > Programs > Accessories > Hyperterminal. 

2. Make a new connection. 

3. In the next pop-up menu, choose direct to COMx, where x is the number of the COM Port 

to be tested. 

4. Set the ‘Flow Control’ to ‘None’. 

5. Select File > Properties from menu bar, select Settings tab, and then click the ASCII 

Setup button. 

6. Check the option for Echo typed characters locally 

7. Start typing. If you see the typed characters show on the screen, means the comm. port 

is functional. 

5.3 How to Troubleshoot Connection from PC to Controllers 

1. At PC, run Hyperterminal or Bray’s Terminal (this program can be downloaded from Elid 

Technical Support Web Site). 

Hyperterminal 

� At PC, select Start > All Programs > Accessories > Communications 

� Make a new connection. 

� Select the COM port number that connected to the controller to be tested. 

� Set the ‘Bits per second’ (the baud rate should be same as controller) and ‘Flow 

conrtrol’ to ‘None’. 
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   Bray’s Terminal 

� Run Bra’s Terminal program, the screen as shown below will appear: 

 

� Select the COM Port and baud rate then click ‘Connect’ 

2. At Controller, go to test communication mode (please refer to controller’s manual for the 

detail on how to log into test communication mode. 

3. Try to observe at both controller screen and PC screen, whatever type from PC should 

echo to controller screen and vice versa. 

Troubleshooting: 

You should go through COM port test to ensure functionality of Com port as describe above 

before undergo following troubleshooting step  

1. Please check whether the baud rate has been set correctly at both PC and controller. 

Both PC and controller should run at same baud rate. If you are using EL70Y as 

communicator, please check the baud rate setting of EL70Y too. 

2. Please check whether any loose wire connection. Use meter to test the continuity to 

ensure no broken wire.  

3. Make sure the communication type of controller is set properly. Some of the controller 

has multiple communication selection. (e.g. EL1330, EL2308 and etc). Check the 

jumper position of RS485 / Multidrop selection of the controller. 

4. If you are using multidrop communication, please make sure the communicator power 

is turn on. 

5. Please make sure the communication line is not exceeded 1km as long distance will 

cause voltage drop and thus affect the communication. 

6. You may try to reset the communicator (e.g. EL70Y) as it could due to communicator 

hang. 

 

 



 

 
 
 

42 

CHAPTER 6 

6.0 LOCAL AREA NETWORK (TCP/IP) 

E.WIN support TCP/IP controllers. Before you can link the IP controller to E.WIN, you must 

configure the IP properties as below of the controller.  

� IP Address 

� Subnet Mask 

� Gateway 

� Port Number 

There are 2 methods to configure the IP properties of the controller, 1) by controller’s keypad or 2) 

using special tool (ZnetCom, IPSearch). Please refer to the corresponding controller manual for the 

detail of IP properties configuration. 

6.1 How to check connection between PC and controller 

Ping the controller’s IP address from PC 

At Command Prompt (Start > All Programs > Accessories > Command Prompt), enter the 

following command ‘ping xxx.xxx.xxx.xxx’ where x is the IP address of the controller. 

Telnet the controller 

At Command Prompt, enter the following command ‘telnet xxx.xxx.xxx.xxx.xxx yyyy, where x 

refer to the IP address of controller and y refer to port number of the controller. The default 

global IP port using in E.WIN is 4001, you can change the port number in Edotwin.ini located 

at C:\Program Files\EdotWIN. 

HyperTerminal 

1. At PC, go to Start > All Programs > Accessories > Communication > Hyperterminal 

2. Make a new connection. 

3. Select connection type as ‘TCP/IP (Winsock)’, then enter the controller IP and port 

number. 
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4. If successfully connected, the bottom left corner of the HyperTerminal screen will show 

‘connected’ 

5. At controller, go to communication test mode. 

6. Try to observe at both controller screen and PC screen, whatever type from PC should 

echo to controller screen and vice versa. 

Troubleshooting 

If you fail to ping the controller IP Address 

1. Please check the LAN cable is connected properly at both ends, is there any poor 

contact? 

2. If the IP Address of the controller is set by controller’s keypad, try to check the 

controller’s IP from ZnetCom utility again, make sure the IP Address is set properly. 

3. Make sure the hub is compatible and able to take 10M transmission speed. 

If you fail to telnet the controller 

1. Please contact IT administrator to confirm whether the particular port is open. 

If HyperTerminal test fail 

1. Please check whether the LAN module is inserted properly, is there connected to wrong 

socket or connection loose? 

2. If you are using EL1330 controller, please make sure the jumper is set to TCP/IP 

communication (short both jumper on JP3); the jumper at serial communication (JP2) 

should be removed. 

3. Is the controller baud rate same as the LAN module baud rate? 

� If you are using Znet LAN module or EL70L (for controller EL1330, EL1370, EL2308 

and etc). 

The baud rate of controller must set to 19200 or ‘LAN’. Then check the baud rate of 

Znet LAN module by using ZnetComm, make sure it is ‘19200’. 
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� If you are using Chiyu LAN module or EL78A (for controller EL3000 and etc) 

Check the baud rate of the LAN module by using IPSearch. 

 

You must set your controller baud rate same as the baud rate highlighted as above. 

 

You can also try to test the system with private LAN first to eliminate the network issue. 

6.2 Encrypted Mode 

Encrypted mode is only available for those controllers that support data encryption, such as 

EL1330. The option is off by default. To turn on, edit EdotWin.Ini, set: 

[Comm Setting] 

LANMode=1 
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A special code call ‘Security Code’ is recognition for both ways to start communicate. Thus, 

once Encrypted Mode is turn on, you must set the security code at controller and E.WIN. 

Security code consist of 4 sets of 3-digit number, each set of number must not exceeded 255. 

1. At E.WIN Manager, go to Setup > System Setup 

2. Enter 4 sets of security code to the following screen 

  

3. Click ‘OK’ to save the setting. 

6.3 Bulk Command 

Bulk command allows install cards in bulk. This command can be enabled from EdotWin.ini 

file.  

[Comm Setting] 

LANCommand=1 

When you try to install all cards, the process will be much faster. 

How to install all cards. 

1. Click at ‘Control’ button, select ‘Card DB Control’. 

 

2. Select the controller to send to. 

3. Select either install card with pin or card only. 

4. Click ‘Install All’. 
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CHAPTER 7 

7.0 BORLAND DATABASE ENGINE (BDE) 

BDE (Borland Database Engine) is the agent or interface to database management systems (DBMS) 

such as Paradox, dBase, and Microsoft SQL Server. It facilitates the connections and allows easy 

switching from one database to another, for example, from Paradox to MS SQL. Therefore, BDE 

allow an application to scale up easily. 

An application will pass a query on database to BDE first before reaching the DBMS, for example, 

E.WIN sends a request to BDE through EdotWin Alias (we will talk about database alias in a short 

while) to the Paradox database. 

 

 

The tool used to configure and setup BDE is called BDE Administrator, which will be available in the 

Control Panel as soon as you finish installing E.WIN as shown in below 
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BDE Administrator in Control Panel. 

BDE – in the context of E.Win 

In E.Win, there are two database aliases used: EsofwinTable and EdotWin. Database alias is a name 

used to refer to a database, typically stored in a folder. So when we mention Alias in the context of 

Paradox, we refer to files kept in a particular folder. 

E.Win keeps the database files in the C:\Program Files\EdotWin folder, thus BDE is set to point to that 

folder: 

 

E.Win alias settings in BDE Administrator 

For Chronos alias, the folder path is pointed to C:\Program Files\Chronos\Database for instead. 
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CHAPTER 8 

8.0 PARADOX DATABASE MANAGEMENT SYSTEM 

E.WIN is using paradox database. Every table of E.WIN will have a set of files that looks like this, 

Table.DB 

Table.PX 

Table.XG0 

Table.XG1 

Table.YG0 

Table.YG1 

8.1 How to fix Paradox database problem 

The most common problem that happens in Paradox database is ‘Index out of date’ error. You 

can reindex the table by using the ‘reindex’ feature that can be found in the utility menu or 

E.WIN folder. 

Perform “Reindex” in E.WIN Manager: 

1. Go to Utility > Reindex. 

 

2. You can either select ‘All Files’ or specify only a particular file using ‘Browse’ to locate the 

file. 

3. Click on the ‘Reindex’ button to start the operation. 

You can also get the similar screen from C:\Program Files\EdotWin\Preindex.exe. If you fail to 

log into E.WIN Manager due to database corrupted, you can run this tool without log into 

E.WIN Manager 
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You can repair corrupted tables by using DB Utitlity (DB_Fix32.exe). This tool can be found in 

C:\Program Files\EdotWin. Once you run this utility, below screen will be appear: 

 

Click on ‘Verify’ button, the utility will start to check the condition of database. A verification 

report will be shown. You can also Re-index the database by clicking the ‘Re-Index’ button. If 

corrupted table found, you can click on ‘Rebuild’ button to rebuild the particular table. 

8.2 Backup & Restore 

This feature is available in Utilities menu. You can select transaction for particular date or 

database to backup from the screen below: 
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Use ‘Restore’ feature whenever you want to restore the data or setting to previous backup. 

You can select the database to restore from below screen: 

  

8.3 Transaction Files 

Once E.WIN Manager scanning start, the transaction will start downloaded from controller to 

E.WIN folder. The raw file will be saved as below format: 

yymmdd.raw  Where  yy represent year of transaction downloaded 

      mm represent month of transaction downloaded 

      dd represent day of transaction downloaded 

The transaction format in the raw file is as following: 

UUUddmmHHMMccccccT 

UUU Controller unit number 

dd Transaction Day 

mm Transaction Month 

HH Transaction Hour 

MM Transaction Minute 

cccccc Card No 

T Transaction Code 

E.WIN will process the raw file and save the transaction for individual date into individual file. 

The transaction file format is as follow: 

TRyymmdd.DB 

You can view the individual transaction file from E.WIN Manager. 

1. Click on ‘Report’ button. 
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2. Click on ‘Open History File’ button. 

3. Select the transaction file (.DB) to view. 

4. Click on ‘View/Print’ button. The content of the transaction file will be shown. 

Troubleshooting 

If you found transaction loss problem in E.WIN 

1. Make sure E.WIN scanning always ‘on’ to download transaction. It is to prevent 

transaction overwritten in controller database. 
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CHAPTER 9 

9.0 TIME ATTENDANCE MANAGEMENT SYSTEM (CHRONOS LINK) 

The standard E.WIN is build in with Chronos Time Attendance Management system. You can also 

integrate E.WIN with E.Time, Multiple-shift Time Attendance Management system. Section 13.2 will 

explain more detail on E.Time integration part. 

At E.WIN Manager, click on ‘Attendance’ button to get into Chronos. 

 

The cardholder details and the first-in-last-out record of each cardholder at each particular day will 

be automatically transferred to Chronos. Therefore, you no need to manage card access system 

and time attendance system separately. 

Troubleshooting 

What to do if Staff Information not transferred to Chronos? 

1. Exit Chronos. 

2. Click <Cards> on the E.WIN main screen to get into card holder screen, 

3. Edit any record, then click <Update> button 

4. Click <Close> button will trigger refreshing of staff information to Chronos. 

5. Go to Chronos to view updated staff information. 

9.1 Attendance Processing 

By default, E.Win will process attendance on-the-fly, such that when you start Chronos, you 

can just view the attendance reports directly without further processing.  

The raw In/Out transactions transferred to Chronos from E.WIN can be viewed from activity 

report. The attendance report of Chronos will be processed according to the working hour set 

by user in Chronos. 
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How to configure the working hour 

Go to Setting > Working Hour 

 

 

 

 

 

 

 

 

 

 

 

1. Select Group (G0 to G5) 

2. Key in the In, Meal Out, Meal In, Out, OT Start and OT End from Sunday to Saturday. 

3. Tick on the days which are off day 

4. Key in the allowed late in, allowed early out, OT minimum and OT rounding minutes. 

5. Tick on ‘Deduct meal hour from total working hour’ if you would like to deduct total meal 

hour from total working hour. If not, please make sure it is not ticked. 

6. Click on ‘Save’ button. 

Terms Explanation 

Allowed Late-in minutes Employee comes late within certain time would not be 

considered as late in. 

Allowed Early-out minutes Grace period for going off earlier than normal office hour. 

OT minimum Employees are required to work OT more than the OT 

minimum in order to have the overtime calculation. 

OT Rounding Employee’s overtime will be rounded down to the nearest 

value. For example, OT rounding is 30 minutes. 

Overtime 40 minutes will be rounded down to 30 minutes. 

Overtime 75 minutes will be rounded down to 60 minutes. 
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Deduct Meal Hour There is an option to deduct total meal hours from total 

working hours when the software calculates the total working 

hours. The total meal hour to be deducted is the total meal 

time which has been defined in working hour. 

For example, if the defined meal out time is 12:30 and the 

defined meal in time is 13:30, the total meal hour to be 

deducted will be 60 minutes and it is not the actual times 

which have been spent by employee for meal. 

Every time slot (WORK IN, MEAL OUT, MEAL IN, WORK OUT, OT IN, OT OUT) have a time 

frame for employee to badge the card. The time frame can be changed by clicking on the 

weekday (Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, and Saturday). 

 

You may see from the screen, the IN TIME range is from 23:01 to 11:59, means that employee 

is allowed to badge for work in between 23:01 to 11:59. For employees who did not badge 

within this period, their attendance will not have the work in time. 
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9.2 How to export transaction to Chronos 

You can also export the transaction from E.WIN to Chronos manually. 

1. At E.WIN Manager, select ‘Export Transaction’ from Utilities menu. 

 

2. Key in the transaction period to be exported. You can also filter the transaction by ‘Staff 

Number’, ‘Controller’, ‘Card Number’, ‘Name’, ‘Department’, and ‘Position’. 

3. Export the transaction as Text File. So the exported file will be saved in .dat format. 

4. At Chronos, go to Utility > Import Data. 

 

5. Select ‘Clocking Data’. At Data Format selection window, tick at ETWIN format as the 

transaction exported from E.WIN is in ETWIN format. 

6. Select the text file previously exported from E.WIN. 

7. After import the clocking data, you have to reprocess the attendance in order to update 

the attendance record. Go to Utility > Reprocess Attendance. Screen as shown below 

would appear. 
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8. Select the employee range and date range that needs to reprocess and click on 

‘Reprocess’ button to start the action. 

Troubleshooting 

Incomplete attendance (Missing IN time or OUT time) 

1. Make sure the working time range is define and set properly as the attendance will 

process according to the range set. It will take the first record within the in time range 

and last record within the out time range. 

For example, if an employee has the badge in record at 07:26, 09:33, 10:03 and 13:22. 

If the IN time range is set to 05:00 to 10:00, then work in time will be 07:26 

If the IN time range is set to 07:30 to 10:30, then work in time will be 09:33. 

2. Check from activity report, is there any record found within the time range has been set 

at the working hour? If yes, you can try to manual reprocess the attendance again from 

utility menu. If no, you can readjust your working time range to cater most of the case 

and manual reprocess the attendance again. 

3. Compare the activity report with E.WIN transaction if you suspect there is transaction 

loss. In this case, you can import the transaction manually as describe in section 9.2 
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PART IV 

TUNING & TWEAKING 
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CHAPTER 10 

10.0 E.WIN TWEAKS 

Some of the settings in E.WIN can be set through a text file named EdotWin.ini. Please be cautioned 

that this feature is more for advanced users who is familiar with the consequences of the settings. 

You may cause the E.WIN failed to start by manipulating the settings in the file. 

Please bear in mind that some of the settings are directly controlled and set from E.Win screens, for 

example, language used. 

10.1 Setting in E.WIN.ini 

The following settings use the convention of 1 as ON and 0 as OFF 

[Comm Setting] 

CommPort=1 

BaudRate=2400 

InterfaceType=EL70 

The Comm Port will be automatically scanned and set by 

E.WIN with license. The comm. port number that can be 

detected by E.WIN is up to 32. 

If you are using E.WIN without license (which can only 

support up to 4 doors), you may need to set the comm. port 

manually by keying in the serial port number that connected 

to the controllers. 

BaudRate is the communication speed between PC and 

controllers. Thus, the baud rate in E.WIN must be same as 

that set in the controllers. Otherwise, PC and controller will 

be failed to communicate. 

For old model of controller, such as EL1300, EL2205 are 

using baud rate 2400. 

For new model of controller, such as EL360, EL370, 

EL1330, EL1370 and EL2308, the default baud rate is 9600. 

InterfaceType is the type of communicator using to transfer 

data between E.WIN and controller in bus 1. 

If you are using EL70X, set InterfaceType=EL70 

If you are using EL38, set InterfaceType=EL38 
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OnLine=1 Set OnLine=1 to allow online scanning of transaction. This 

will allow transaction immediately retrieved to E.WIN so that 

it will not be accumulated. 

It is advisable to always set to 1 as controller has limited 

space for storing transactions. Once the transaction is 

exceed the storage limit, it old transaction will be overwritten 

and cause “missing of transaction”. 

OnLinePrinting=0 Online Printing 

BuzzerOnAlarm=0 Sound the buzzer if alarm transaction 

MultiCommSupport=0 

CommPortList=27010203 

Set MultiCommSupport=1 if you have more than 1 bus (16 

units) of controllers. 

Since each bus is on a separate serial port, you can specify 

what comm. port is meant for which bus 

e.g. Set 

CommPortList=27010203 

Menas bus 1 is on COM27, bus 2 on COM1, bus 3 on 

COM2, bus 4 on COM3. 

CommTimeOut10ms=200 Duration E.Win waits before declare as No Response from 

a controller. It is in unit of 10 miliseconds, 200 means 2 

seconds. 

IPPort=4001 IP port used in TCP/IP communication from E.WIN to the 

access controller based on LAN. 

This is the global setting for all the controllers linked through 

LAN (Local Area Network) 

LANMode=0 

LANCommand=0 

Set LANMode=1 to turn on Encrypted Mode communication 

from PC to IP based access controllers. 

LANCommand=1 allows Bulk commands to be sent. 

Typically, this mode speeds up card installation process 

In Bulk mode, 1000 cards can be installed in 1 minute 

instead of few minutes. 

NOTE: These 2 commands apply only to EL1330 ver 1.1.x 

and above. 

DeviceDownCount=1 Number of try to get transactions from a controller before 

declares as ‘Controller Down’. 
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Map Setting 

MaxMapPause=2 Map switching rate in seconds 

BMPOnly=1 BMP files only, set to 0 for other File format, e.g. JPG and 

etc. 

ShowDeviceTag=1 Display device tag below the controller icon 

Access Report 

TransSelect=111111111111111111111111111111 

 Selected Report transactions (maintained by E.WIN, 

do not change) 

EsofproTrans=0 Esofpro Compatible format 

Comma Delimited=0 Export transactions in comma delimited format 

TimeClock=1 Prepare clock data for Chronos 

OnTimePath=c:\progra~1\chronos\ Time Attendance directory 

DirectPrint=1 Set to 1 for dot matrix printer while using on-line 

printing feature. 

Set to 0 means requesting E.WIN to print on the page 

by page basis. 

TemporaryCard=0 Allow temporary card 

System Status 

Query=1 Query for device status, e.g. Door Open. 

DiskSpaceWarning=10 Display warning message if hard disk free space < n 

Megabytes 

EL1200QA=1 Enable small data packet when polling EL1200. This 

will override ‘Query=?’ setting. 

Options 

CondIOEnabled=0 Enable conditional I/O in E.WIN Designer. 

LatestPhotoEnable=1 Enable triggering of photo for latest transaction. Such 

as valid entry, valid exit, invalid entry, wrong pin, 

wrong time zone and duress alarm. 

RetainOnlineScr=1 Retain transaction on online transaction screen for 

next launch. 

TreeView=0 Show tree view panel at the left side of online 

transaction screen. 
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POllDelay=2 

polldelaySec=0 

PollDelay controls speed of communication in 

general, applies to polling as well as commands sent. 

PollDelaySec is purely meant for delaying the process 

of polling transactions. Allow less frequent controller 

polling. This is for situation where only 1 controller is 

used, and PC polls the controller so fast that card 

reading becomes a problem for the controller. More 

for older model of EL1300. 

HolidayIgnoreYear=1 Set to 1 means requesting E.WIN to download date of 

holidays by month and day irrespective of year, to the 

controllers. 

International=0 

LanguageFile=chi_gb.txt 

LanguageID=0 

Set international to 1 to enable language display other 

than English 

LanguageFile specifies which text file to be read as 

translated text. 

LanguageID is meant for controlling text display. 

1 for Chinese GB (Mainland China) 

2 for Chinese BIG5 (HK & Taiwan) 

3 for Malay 

4 for Thai 

User is advised not to edit these settings directly, but 

set it through the E.Win Preferences screen. 

DailyUpdateControllerTime=1 Set to 1 to ask E.WIN to send date/time to all 

controllers during midnight daily. 

To have that feature, E.WIN will need to be running 24 

hours x 7 days. 

AutoPreindex=1 Database / index scanning upon startup 

IgnoreInOutCode=1 Allow you to use in reader for both in / out time 

clocking 

OnlineTransparency=225 Set the transparency level of online transaction 

window. Bigger value means less transparent 
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LimitedEdition=1 Without license, E.WIN supports up to maximum of 4 

controllers, with full functionalities. 

Once LimitedEdition=1, you will need to make sure 

the serial port that you specified under [Comm 

Setting], CommPort=x is actually the one you linked 

to the EL70Y or EL70T. 

Under LimitedEdition mode, E.WIN does not perform 

key detection, thus does not scan through serial port 

one by one to figure out which port is used. 

EWTMS=0 When EWTMS set to 1, the TMS module using in 

E.WIN is the simplest TMS module. 

If you want to integrate E.WIN with Chronos or E.Time 

Time Management system, EWTMS must set to “0” 

EnableAttendAgent=1 

Chronos_Link=1 

EWTMSDBPath=C:\progra~1\chron

os\database\ 

Attendance Agent processes attendance on-the-fly, 

such that you can view attendance report directly after 

running Chronos. 

E.WIN can be integrated with either Chronos or 

E.Time. 

To integrate E.WIN with Chronos, add the command 

Chronos_Link=1, and key in the database directory at 

EWTMSDBPath. In this case, the Chronos database 

is located at C:\Program Files\Chronos\Database. 

To integrate E.WIN with E.Time, add the command 

ET_Link=1 and EWTMSDBPath should point to 

E.Time database. 

Please note that for standard installation, E.WIN by 

default has been pre-configured to work with 

Chronos, therefore, you do not need to set any of 

these. 

While for E.Time integration, there is a tool named 

ET_Link.Exe that will configure all the settings for you. 

AutoInsDelImportedCards=1 This command will enable the auto update of 

employee database in Chronos / E.Time according to 

the E.WIN card database. This is to prevent any 

changes made in card database of E.WIN not 

synchronize to Chronos / E.Time. 
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EWTMSAllInOut=1 To push all in and out transaction from E.WIN to 

Chronos / E.Time instead of only first in and last out 

transaction. 

OTPCutOffTime=0700 Allow proper processing of attendance, especially 

those across midnight. 

Web Server 

WebEnabled=1 

IPPort=8080 

Set to 1 to enable Tiny Web Server, with the condition 

that you have E.WIN license added with Web Module. 

By default it is off to avoid conflict with IIS or Apache 

installed on certain PC. 

If you wish to run E.WIN Web Server on other port, 

just set IPPort to the value you wish, e.g. IPPort=8080 

WebExpiredSec=60 To protect user from accidentally forget to logout 

E.WIN Tiny Web Server, you can set the 

WebExpiredSec to automatically logout the user. In 

this case, 60 seconds idling will cause E.WIN to log 

the user out. 

[Cards] 

ET636CommPort=22 

ET636Reader=1 

E.WIN supports USB linked ET636 card reader. 

Set ET636CommPort to the comm. port created by 

USB linked ET636. 

Set ET636Reader=1 to enable ET636 interface. 
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CHAPTER 11 

11.0 E.WIN DESIGNER (HOW-TOS) 
 

11.1 How to load a new floor plan in E.WIN Designer? 

You can insert site plan at Designer, the site plan can be in BMP or JPG format. At E.WIN 

Designer, click on ‘Add’ button. 

1. Click on ‘Map’ button to select a map. 

3. Call out directory and choose your required file 

4. Click on ‘Load’ button 

5. Click ‘OK’ 

6. Change the ‘Floor Plan Tag’ and ‘Description’ 

7. Click on ‘Save’ button 
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11.2 How to setup multi-buses (comm.) system? 

1. At C:\Program Files\EdotWin\EdotWin.ini, enable multi-buses by enter the following 

command: 

[Comm Setting] 

MultiCommSupport=1 

2. Redirect bus1, bus2, bus3 and bus4 by using CommPortList in EdotWin.ini 

For example,  

‘CommPortList=02060305’ 

Which  first two digit, 02 represent use COM2 as bus 1 

           second two digit, 06 represent use COM6 as bus 2 

      third two digit, 03 represent use COM3 as bus 3 

      last two digit, 05 represent use COM5 as bus 4 

3. Alternatively, you can also assign the comm. port for each bus at E.WIN Designer > 

Detect 

 

11.3 How to interface fire alarm to unlock all doors? 

1. Enable the Conditional I/O at EdotWin.ini by adding the following command. 

[Options] 

CondIOEnabled=1 

2. At E.WIN Designer, define a sensor that connects to fire alarm panel. 



 

 
 
 

68 

 

 

1. Key in the sensor logical point 

number. 

2. Select whether the sensor is 

attached to controller. 

3. Select the controller name that 

sensor attached to. 

4. Select ‘Alarm’ as Operating 

Mode. 

3. Select Conditional IO menu, the following screen will appear: 

 

4. Click on ‘+’ button to add a new condition. 

5. Key in Code and Description. 

6. Generate a rule that following condition applied. 

If ‘Sensor Alarm’ then ‘On Permanent Lock Release’ for every door. 

7. Click on ‘Generate’ button.  

11.4 How to check if a controller is up and running? 

1. At E.WIN Designer, click on ‘Detect’ button. 

2. Select the controller unit to scan. 

3. Click on ‘Scan’ to start detect the controller, if controller is up and running, the scanning 

result window will show the controller model and it’s firmware version number. 
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CHAPTER 12 

12.0 E.WIN MANAGER (HOW-TOS) 
 

12.1 How to change online transactions screen transparency level? 

The online transaction screen transparency level can be changed from EDOTWIN.INI file. 

[Options] 

OnlineTransparency=225 

You can adjust the figure from range 50 to 250 

12.2 How to export transactions other than IN / OUT? 

The standard export transaction is only able to export valid IN/OUT transaction. In order to 

export the selected transaction, you may need to export it to text format but save it as .ACS 

format. 

1. At E.WIN Manager, click on ‘Report button. 

2. Then select time range of transaction to be exported and you can also filter the 

transaction by ‘Reader’, ‘Employee No.’, ‘Card No.’, ‘Name’, ‘Department’ and ‘Position’. 
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3. Click on ‘Select Transaction’ to select type of transaction to be exported, and then click 

ok to save the setting. 

 

4. Click on ‘Export’ then ‘Save…’, select the directory to save the transaction, the file must 

be save in ASCII format. 
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12.3 How to setup E.WIN to interface to modem linked controllers? 

1. At remote site, prepare special cables run from EL70B to the modem. Every site must 

have one cable, one EL70B and one modem. 

The pin connections are as follows: 

Male 9 (EL70B)      Male 25 (Modem) 

(RD) 2       2 (TD) 

(TD) 3       3 (RD) 

    5       7 (GND) 

           4 (RTS) 

           5 (CTS) 

           6 (DSR) 

           8 (CD) 

           20 (DTR) 

 

        OR 

 

Male 9 (EL70B)      Male 9 (Modem) 

    2       3 (TD) 

    3       2 (RD) 

    5       5 (GND) 

           7 (RTS) 

           8 (CTS) 

           6 (DSR) 

           1 (CD) 

           4 (DTR) 

2. Prepare modem and standard modem cable from PC to modem at E.WIN PC. 

3. At remote site, on the modem first, then wait for a seconds, on the EL70B, you should 

see the modem set to AA (auto answer mode) 

4. At E.WIN PC, edit C:\Program Files\EdotWin\ewdialer.ini. Set the comm. port where 

modem is linked, for example, if modem is linked to com 2: 

[Comm Setting] 

CommPort=2 

5. At E.WIN Manager, go to Control menu > Modem 
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6. Click on ‘Setup’ button to add new remote site. (There are two sample sites defined by 

default, for demonstration purposes) 

 

7. Click ‘Add’ button. 

8. Key in the ‘Tag Name’, ‘Description’ and ‘Telephone No.’. 

9. You can select ‘Auto Dial Every N Minutes’ is you want auto dial-up by E.WIN to the 

specific remote site every N minute. Otherwise, you can manual dial and hang-up from 

‘modem’ screen.  

Caution: enable this option only when you are very sure you want the feature. Leaving it 

running unattended for months can be disastrous – hefty phone bill will be right at your 

doorstep. 

10. There are two options to limit the connection time to a site, you can choose either one for 

your application. 

� Stay on-line for only N number of minutes. 

� Stay on-line until there is no more transactions receive from the remote site. 

11. You have to assign the controllers required for monitoring from remote site by using ‘<<’ 

button to select. 

12. Click ‘Close; button to return to the previous page once finish setup. 
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12.4 How to use ET636 for reading card directly into E.Win ? 

ET636 is a USB based card reader that supports EM, MIFARE, etc card formats.  

1. Install the USB driver of ET636. 

2. You can check the Windows Device Manager for comm port created when ET636 is 

inserted into one of the USB port on your PC as shown below. ET636 has created a 

serial port COM 10. 

 

3. Click on “My Computer”, then select drive C:, then look for C:\Program Files\EdotWin 

folder. Double click on the file EdotWin.Ini to edit (most likely it will bring up NotePad). 

[Cards] 

ET636CommPort=10 

ET636Reader=1 

4. Save and Exit from Notepad 

5. Run E.WIN, go to Card Holder screen, you will see: 
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6. Badge a new card on ET636 will automatically insert the new record into Card database, 

change name or whatever fields you wish to change, then click ‘Update’ to save the 

record. You can repeat the steps for a stack of cards. 

7. If the card badged already exists, E.WIN will bring up the record for you to edit, thus 

saving time to search the database for that record. 

12.5 How to setup MIFARE duplicate cards management using ET636 ? 

Due to the fact that MIFARE cards can be purchased from any suppliers, the serial number 

read from the cards quite often is not unique. Therefore, E.WIN has provided a method where 

the situation can be handled. 

The trick is simple, We provide a special MIFARE ET636 card reader where the duplicate 

MIFARE cards will be mapped to new numbers. Because of that, all cards to be installed to the 

controllers will need to be read by this ET636 reader, and insert into E.WIN database to 

ensure the uniqueness of the card numbers. 

To setup up E.Win for this purpose, first we get ET636 enabled and connected as explained in 

section 12.4 (Interface to ET636). 

Then you need to turn on another flag in EdotWin.Ini for the purpose of maintaining MIFARE 

duplicate cards: 

   [Cards] 

   MIFAREDupCardDB=1 
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The special MIFARE ET636 card reader will maintain the mapping and you can add / delete 

cards as if you are using standard ET636 interface to insert cards, without the need to know 

the actual details how the duplicate cards mapped. 

 

In additional to ET636 setup, you also need controllers that support the feature. Currently only 

EL1330 has the option. Make sure you have the right controllers before using this feature.  
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CHAPTER 13 

13.0 MICELLANEOUS (HOW-TOS) 
 

13.1 How to toggle between scanning on/off? 

Transaction scanning can be on or off by double click at the scanning window as shown: 

 

 

 

 

 

Alternatively, you can turn it on/off in the Setup/Preference/online scanning tab; just tick the 

check box [X] online scanning. 

13.2 How to integrate E.WIN to E.TIME? 

1. Install E.WIN. 

2. Install E.Time 

3. Run ET_Link.exe 

 

After run ET_Link.exe, the following setting will be changed: 

EDOTWIN.INI 

[Access Report] 

OntimePath=C:\Progra~1\EdotTime 

[Options] 

EWTMSDBPath=C:\Progra~1\edottime\database 

EdotTime_Link=1 

 

E.Time setting.ini 

[License] 

EnableEw2tms=1 

13.3 How to enable E.WIN limited edition? 

E.WIN can support up to 4 doors without software license key. After installation, E.WIN by 

default will detect key, if no key detected, it will go into demo mode. To enable to limited edition, 

Double click at here to turn on or 

turn off scanning 
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just add / edit following command at EdotWin.ini. 

    [Options] 

    LimitedEdition=1 

   Alternatively, you can enable it through Setup/Preferences/Option tab, then tick the checkbox  

   [X] Limited Mode. Bear in mind that under limited mode, no automatic comm port detection is  

   performed. Therefore, go to Setup/Communication Setup screen, drop down the comm port  

   combo box, and select the right comm port (most likely only 1 choice there). 

 

   If you are not sure which comm, go to Control Panel | System | Device Manager | Ports (COM  

   & LPT), pull out EL70Y USB connector, see which comm is missing; then confirm again when  

   insert back the USB connector. 

13.4 How to migrate from Chronos to E.Time 

Chronos is single shift software while E.Time can handle multiple shifts. Thus, E.Time needs 

more settings.  

 

1 Install E.Time first, then follow by ET_link.exe. 

2 Run E.WIN Manager and click on ‘Attendance’ button, the time attendance now will 

change to E.Time. Below is the parameter need to set in E.Time: (Please refer to E.Time 

manual for more details) 

� Assign group number for each employee. (You can try to edit the staff information 

at E.WIN card database and run attendance again if the employee information not 

transfers to E.Time properly). 
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� Set the working schedule for each shift group at ‘Setting’ menu. 

 

� Assign shift time table for every group of employee by using duty roster. 

 

3 Export the transaction from E.WIN. 

4 At E.Time, import the data that previously exported from E.WIN. (in ETWIN format) 

5 After importing the clocking data, E.Time will automatic reprocess the attendance 

according to the setting in E.Time. 
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13.5 How to upgrade from EsofWIN 

1. Install E.WIN to the PC 

2. Rename the EdotWin folder, for example, EdotWin_1 

3. Rename the EsofWIN folder to EdotWin. 

4. Copy all the .dll, .ini and .exe file from the new installed EdotWin (which has already 

rename to EdotWin_1) to the EdotWin folder (which rename from EsofWin) and replaced 

the existing file. 

Please take note that E.WIN uses E.Key which is different from the old EsofKey. Thus. if you 

have more than 4 controllers and using EsofKey all this while, remember to get the EL70Y and 

E.Key before upgrading to E.WIN. 

13.6 How to test a remote site linked by modem? 

In E.WIN Manager, there is a feature that can test the modem, called ‘Modem Tester’ 

1. Go to Control Menu > Modem Tester. 

 

2. Select the serial port that modem is linked. 

3. Send ‘AT’ command, if modem is connected properly, <AT OK> will be shown on the 

screen. 

4. Try to dial the remote site by using ATDT command. 

13.7 How to access E.Win through web browser (IE)? 

1. Enable the web server service by setting the EdotWin.ini at the E.WIN PC. 

[Web Server] 

WebEnabled=1 

2. Point to the web browser from the PC that networked to E.WIN. 

3. Enter the IP address of E.WIN PC as URL. e.g. E.WIN PC has the IP of 128.100.34.55, 

then you should enter URL as http://128.100.34.55. 
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4. By default, E.Win Tiny Web Server is listening on standard port 80, if you prefer to let it 

listen on other port, you can define in EdotWin.Ini, say, port 8080: 

[Web Server] 

IPPort=8080 

   Then you need to point your browser to URL as http://128.100.34.55:8080 
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CHAPTER 14 
 

14.0 FREQUENT ASKED QUESTIONS 
 

14.1 Why no transaction is retrieved after I cold started a controller? 

After cold start a controller, the controller date and time will reset to (9/9/1989 00:01), which 

the date and time not recognize by E.WIN. E.WIN will automatic filter the transaction of 

un-recognize date / time. Thus, everytime after cold start the controller; please make sure 

send the date / time from E.WIN to controller. 

14.2 Do I need license for using Chronos ? How about E.Time ? 

E.WIN/0, free version which support up to 4 doors only allowed integrating with Chronos. 

E.WIN with license can integrate with either Chronos or E.Time without purchase TMS license 

separately. 

14.3 When try to send timer to controller, error message shown on software ‘timer not found 

in the controller’ 

It is due to timer table corrupted. It can be solved by either re-create a new timer with new 

timer entry or send back the database for fixed. 

14.4 How to turn on E.WIN debugging mode? 

E.WIN will log the activities to a log file. This log file can be found in E.WIN folder, the file 

name is TRC_YYMM.log, which YY is the year and MM is the month. You can check any 

abnormality of software from this log file. By default, the debugging mode is off. 

E.WIN can also run in debugging mode which will log more information and tells what have 

been happen in E.WIN software. This mode can be enabled by adding below command in 

EdotWin.ini. 

 [Options] 

 Debug=21 

It is recommended to turn on debugging mode only when you face serious problem. 

Remember to turn off the debugging mode after run the E.WIN and generate the problem. You 

can send the log file to ELID for analysis if you unable to read the content of log file. 
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Below is an example of log file for default debug level and high debug level when run the 

software without license key and limited edition is disabled. 

 

Log file when debug mode is off 

08/02/10 21:58:27  E.Win Manager 2.0.7.43 Started. 

08/02/10 21:58:27  Paradox Database 

08/02/10 21:58:28  <SaveIniInfo1>Unable to open com port: COM1 

08/02/10 21:59:01  <GetLEK.3> Unable to open com port: COM1 

 

Log file when debugging mode is on 

08/02/10 22:01:10  E.Win Manager 2.0.7.43 Started. 

08/02/10 22:01:10  Paradox Database 

08/02/10 22:01:10  Trans.db found, recreate indexes. 

08/02/10 22:01:10  Clr_s=NAVY 

08/02/10 22:01:10  Clr_s=LIME 

08/02/10 22:01:10  E.Time Link 

08/02/10 22:01:10  EWTMS - All In/Out ON 

08/02/10 22:01:10  Carparkcounters= 

08/02/10 22:01:10  <saveini> max unit=16, 

08/02/10 22:01:10  <SaveIniInfo1>Unable to open com port: COM1 

08/02/10 22:01:10  D.Mode = 21  Path=C:\Program Files\EdotWin\ 

08/02/10 22:01:10  OS  = Windows NT 5.1 (Build 2600: Service Pack 2) 

08/02/10 22:01:10  H/D = 74 GB  Free: 41744 MB 

08/02/10 22:01:10  RAM = 893 MB 

08/02/10 22:01:10    Total Cards = 8 

08/02/10 22:01:12  EMain.FCr.End 

08/02/10 22:01:12  MapPanel.FCr.End 

08/02/10 22:01:12  Serial: COM3 

08/02/10 22:01:17  [] 

08/02/10 22:01:17  COM3: No E.Key Found. 

08/02/10 22:01:35  <saveini> max unit=16,/0 

08/02/10 22:01:35  <GetLEK.3> Unable to open com port: COM1 
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Appendixes 

Appendix A : Card Import Text Format (Comma Delimted) 

OC,SN,C,N,D,JT,M,P,AL,SD,ED 

Code   Description      Length 

OC   Operation Code (A=Add, D=Delete)  1 

SN   Staff Number      12 

C   Card Number      6 

N   Name       20 

D   Department      25 

JT   Job Title       25 

M   Miscellaneous      20 

P   Pin        4 

AL   Access Level      12  Optional 

SD   Start Date       8 

ED   Expiry Date      8 

For example, A,T0001,038880,Johnson Lim,Marketing,Manager 

Appendix B : Transaction Export Format 

Text Format 

There are three format supported depend on the condition set in EdotWin.ini 

If EDotWIN.INI.Timeclock=1 then 

Format 3 

Else if EdotWIN.INI.EsofproTrans=1 then 

Format 1 

Else 

Format 2  

Format 1 (EsofproTrans=1 in EdotWin.ini) (*.ASC) 

Column Name Type Length 

<Controller Tag> Char 8 

<Date> Char 4 

<Time> Char 4 

<Card Number> Char 6 

<Name> Char 20 

<Staff Number> Char 12 

<Department> Char 8 

<Job Title> Char 8 

<Transaction Code> Char 1 



 

 
 
 

84 

Format 2 (EsofproTrans=0 in EdotWin.ini, by default) (*.ASC) : 

Column Name Type Length 

<Controller Tag> Char 12 

<Date> Char 4 

<Time> Char 4 

<Card Number> Char 6 

<Name> Char 20 

<Staff Number> Char 12 

<Department> Char 25 

<Job Title> Char 25 

<Transaction Code> Char 1 

 

Format 3 (TimeClock=1 in EdotWin.ini) (*.DAT) : 

Column Name Type Length 

<Clock Number> Char 12 

<Date> Char 6 

<Time> Char 4 

<Card Number> Char 6 

<Job Code> Char 3 

<Transaction Code> Char 1 

 

Excel format 

Column 1  : Device Name 

Column 2  : Date 

Column 3  : Time 

Column 4  : Card Number 

Column 5  : Name 

Column 6  : Staff Number 

Column 7  : Department 

Column 8  : Position 

Column 9  : Transaction 

Column 10 : Transaction Code 

 


